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UNIT 1 

 COMPUTER BASICS 

1.1. Introduction to Computer 

# Computer: Computer is an electronic device which accepts input, processes it and 

produces the desired output. 

Figure 1.1: Computer 

# How does the Computer Works: 

 Data comes in through an Input device, and is sent to the memory unit.

 CPU processes the data, based on the input data and the program which is installed in

the computer memory.

 When the CPU has finished processing the data, it is presented through the output

device as information.

 The information can be stored in the computer memory or presented through an

output device.

1.2. Starting and Shut Down the computer 

# Step-by-step instructions to Start (turn on) the computer 

 Connect the power cable of CPU to power supply board and switch it on.

 Connect the power cable of Monitor to power supply board switch it on.

 Find the ‘on’ button present on the monitor and Press the button.

Figure 1.2: Power Button 

 Find the ‘on’ button present on the CPU and Press the button.

 Log in. (If some password is set for log in to the computer, enter it. Otherwise desktop

screen will appear automatically).
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# Turn off the computer 

 Turn off the computer is also called as Shut down the computer. 

 Shutting down a computer closes all of the programs that are open and exits the 

operating system safely. 

# Step-by-step instructions to turn off the computer 

 Click on the start button  

 

 

 

Figure 1.3: Start Button 

 Click on the Shut down button. 

 

 

 

 

 

 

 

 

Figure 1.4: Shut down button 

1.3 Identify the parts of Computer and their functionality 

 

 

 

 

 

 

Figure 1.5: Basic parts of the computer 
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# Central Processing Unit 

 CPU is called as the brain of the computer. 

 It has three subsystems. They are Memory unit, Arithmetic and logical unit and 

Control unit. 

 Memory unit stores the data and instructions. 

 Arithmetic and Logical Unit perform arithmetic operations and logical operations. 

 The Control Unit directs the operation of the other units by providing timing and 

control signals. Most computer resources are managed by the CU. 

# Monitor 

 The monitor is a commonly used output device. 

 The monitor is also called as Visual display Unit. 

 It displays the result to the user.   

# Keyboard 

The keyboard is a commonly used input device. 

 A keyboard is used to enter information and instruction into a computer. 

# Mouse 

 Mouse is also a commonly used input device. 

 It is also called as a pointing device. 

 It can be used to move the cursor on the screen. 

1.4 Identify the keys of keyboard (alphabet keys, numeric keys, 

caps lock, space bar, back space/del, enter key, arrow movements) 

# Alphabet keys 

 Alphabet keys are used to type a set of letters (or characters) from A to Z. 

 

  

 

 

Figure: 1.6: Alphabet keys 
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# Numeric keys 

 Numeric keys are used to type a numeric numbers using digits from 1 to 9. 

 

 

 

 

 

 

 

Figure 1.7: Numeric keys 

# Caps lock 

 Caps lock is a manipulative key, which are non printing character that are used to 

change the appearance. 

 The caps lock key is used to type the alphabet key in capital letters. 

 By default caps lock key is off. 

 When the user wants to type the alphabets in capital letter, caps lock key is to be 

pressed once. Once again caps lock is pressed then it turns to off mode. 

 

 

 

 

Figure 1.8 : Caps lock key 

# Space bar 

 The space bar is a horizontal bar in the lowermost row, which is wider than other 

keys. 

 Its main purpose is to enter a space, for e.g., space between words during typing. 

 

 

Figure 1. 9: Space bar key 
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# Backspace: Backspace key moves the display cursor one position backwards, deletes 

the character at that position, if any, and shifts back by one position. 

 

 

 

Figure 1.10 : Backspace 

# Del key: The delete key is used to delete the character ahead the cursor. 

 

 

 

 

Figure 1.11: Del key 

# Enter key: The enter key is used to bring the cursor to next line. 

 

 

 

Figure 1.12: Enter key 

# Arrow movement's key: Arrow keys or Cursor movement keys are used to move 

the cursor in a specified direction. Arrow keys are commonly used for navigating around 

documents and for playing games. 

 

 

 

 

 

Figure 1.13: Arrow movement key 
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1.5 Identify the buttons of Mouse (Left, Right, Scroll) 

 

 

 

 

 

 

 

 

 

Figure 1.14 : Buttons of Mouse 

# Left button 

 Left-clicking is used for selecting objects, opening hyperlinks, and closing windows. 

 Clicking and holding the left mouse button can be used to select text or perform drag 

and drop operations. 

 In video games, left-clicking is typically used to perform the primary action, such as 

moving a character or firing a weapon. 

 Double-click of the left button is generally used to open a file, a folder, or a program.  

# Right button 

 The right mouse button is often used to open pop-up menus that change depending 

where you click.  

 For example, If you right click on a folder, the menu might include options such as 

"Open" and "Properties."  

# Scroll 

 The scroll wheel is normally located between the left and right mouse buttons. 

 It is used for scrolling up and down on a page. 
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1.6 Precautions to be taken while opening and closing computer 

# Precautions to be taken while turning on the computer 

 Make sure that all the power cables are connected to the power sockets. 

 Don't touch the pins or other connectors. 

 The table should be clean and non-metallic to avoid short circuits. 

 When working on a computer avoid places that are damp, subject to temperature 

extremes, dirty, or dusty. 

 When possible, try to avoid working in carpeted areas. Carpeting greatly increases 

static buildup within your body. 

# Precautions to be taken while turning on the computer 

 Save all the files. 

 Do shutdown properly, don’t switch off the power supply directly. 

1.7 Do’s and Don’ts of Computer Lab 

# Do’s in the Computer Lab 

 Make a line from the class while coming to or going from the lab. 

 Remove your shoes outside the lab and keep it on the shoe rack. 

 Occupy your allotted place and sit properly (straight). 

 Keep a distance from the monitor to protect your eyes. 

 Keep silence  

 Listen to the teacher’s instruction. 

 Handle the devices like keyboard and mouse gently.  

 Save your files in a folder and turn off the computer with teacher’s permission.  

# Don’ts in the Computer Lab 

 Don’t bring food items or drinks to the lab. 

 Don’t bring pen drive, Compact Disk (CD) and Digital Versatile Disk (DVD) to lab 

without computer teacher’s permission to the lab. 

 Don’t play or run in the lab. 

 Don’t fight with your teammates for your turn to work on the computer.   

 Don’t touch any computer parts unnecessarily (Like cables, CD Drive, Start button, 

etc.,). 

 Don’t change any computer setting in the lab computer. 

 Don’t open other students' files. 

 Don’t access any other software without teacher’s permission. 

 Don’t turn off the power supply directly before shut down the computer. 
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Figure 1. 15: Do’s and Don’ts of Computer Lab 
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1.8 Features of the Computer 

 Speed 

o The computer has a very speed of executing instruction.  

o CPU of a computer can perform more than 10 million operations per second.  

 Storage 

o The computer can store large amount of data and information. 

 Accuracy 

o The accuracy of results computed by a computer is consistently high. 

 Reliability 

o The quality of performing well always without fail. 

 Versatility 

o Computer is applicable in all the fields. 

 User friendly 

o Anybody who does not have much knowledge about computer can also 

operate it because of GUI (Graphical User Interface) facilities. 

1.9 Strengths and Limitations of Computer 

 Speed, storage, accuracy, reliability, versatility and user friendliness are the strengths 

of the computer. 

 Lack of decision-making power and no IQ (Intelligence Quotient) are the weakness of 

the computer. 

Word Meanings 

1. Manipulative key- A Key which does not print characters and make changes in the 

appearance and layout of the text on the page. 

2. Cursor:  A cursor is the position indicator on a computer display screen where a 

user can enter text. 

3. Precautions: an action that is done to prevent something unpleasant or dangerous 

happening. 

4. Damp- wet 

5. Teammate -a fellow member of a team. 

6. Reliability- the quality of performing well always. 

7. IQ (Intelligence Quotient) -  a total score derived from one of several standardized 

tests designed to assess human intelligence. 
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EXERCISES 

I. Fill in the blanks with the correct answer by using the words given below 

in the box. 

 

 

1. Data can be entered in the computer through an __________________ 

device. 

2. The CPU is called as the __________________ of the computer. 

3. ____________________ unit of the computer stores data and 

information. 

4. Addition and multiplication operations in the instructions are 

performed by          __________________________ Unit. 

5. ______________________ keys are used for typing the text 

information.  

II. Arrange the jumbled words using the hints given below and fill in the 

blank.  

 1. LSLORC _________________________. 

  [Hint: This mouse action is used to move up or down on a page]. 

2. BUODLE-LKCIC _______________________ . 

 [Hint: This mouse action is generally used to open a file, folder, or 

program]. 

3. ESVA _____________________ .  

[Hint: This action is used to keep the documents and files for further 

reference and use]. 

4. MEROCPUT____________________________ 

[Hint: This is an electronic device which accepts input, processes it and 

produces the desired output.] 

Memory, Alphabet, Input, Brain, Arithmetic and Logical 
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III. Match the following keys given in the column-I against the purpose 

given in the second column and write the respective alphabets in the below 

given line.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Answers: 1. _______,  2. ________, 3. ________ 4. ________, 5. _________. 

 

 

 

 

Column-I 

Keys 
Column-II 

purpose 

1. 

A. Used to delete a character ahead 

the cursor. 

2.  

 B. Used to enter a space between 

the words. 

3.  

C. Used to type the alphabet keys in 

capital letters. 

4.   

D. Used to bring the cursor to the 

next line. 

 

5.  
E. Used to delete the character at the 

back of the cursor and shifts the 

cursor back by one position. AEES
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IV. Solve the crossword puzzle. (Clue: Use, the terms of “characteristics of 

computers”). 

  

 

 

 

 

 

 

 

 

V. Label the parts of the computer  

 

 

 

 

 

 

 

PRACTICAL EXERCISES  

1. Turn on and Shut down the computer. 

ACTIVITIES IN THE CLASS 

1.  Debate on the topic “Strengths and Limitations of computer” 

2. Show the mouse and keyboard in the class while explaining the topics “ Identify the keys” 

and “ Identify the buttons of mouse”. 
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UNIT II  

USING PAINT BRUSH 

2.1 Introduction 

 Paint is a simple raster graphics editor that has been included with all versions 

of Microsoft Windows. 

 The app opens and saves files in Windows bitmap (BMP), JPEG, GIF, PNG, and 

single-page TIFF formats.  

 JPEG- Joint Picture Expert Group 

 PNG- Portable Network Graphics 

 GIF- Graphics Interchange Format 

 TIFF- Tagged Image Format File 

 Microsoft Paint has a collection of painting Tools that can used for drawing colorful 

images and shapes. 

2.2 How to start paint brush 

 Click on Start button on the status bar.  

 Click on All Programs option in the submenu. 

 Click on Accessories option in the submenu. 

 Click on Paint option. 

 

 

 

 

 

 

 

 

 

 

Figure. 2.1: Starting paint 
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2.3 Home Tab 

 For nearly everything you do, you'll want the Home tab to be at the front.  

 The Home tab contains the Ribbon, from which tools and colours are selected.  

 

 

 

Figure. 2.2: Home tab 

2.4 Pencil, Eraser, Fill with color, pickcolor, brush, Air brush 

 

 

 

 

 

 

Figure 2.3: Paint tools for Windows 7, 8 and 10 

# Pencil: It is a basic drawing tool, which allows to draw the images with free form lines 

and curves. 

 

 

Figure 2.4: Pencil tool 

.  The pencil's thickness can be changed in the Size tab to 1, 2, 3 or 4 pixels. 

 

 

 

 

 

 

 

 

Figure 2.5: Pencil tool thickness in different size 
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# Eraser: A free form eraser. Used to erase the objects drawn. 

 

 

Figure: 2.6: Eraser tool  

 How to use the eraser tool: 

o Click on the eraser tool. 

o Click on the part of the image that you want to erase.  

The erased part of the image back to the background color of the image file. The 

eraser tool size can also be changed using size tab. 

# Fill With Color: Allows you to fill an entire area with a single color. 

 

 

 

Figure: 2.7: Fill with color tool  

# Pickcolor tool 

 Pick color tool is used to "pick up" colors that is already used in the image. 

 Also known as the eye dropper,  

 

 

 

 

Figure 2.8: Pick color or eye dropper 

# Brushes  

 Brushes are used to paint in various widths and textures.  

 Different colour and type of brushes can be used for painting. 

 Square, round, and slanted shaped brushes, of various sizes can also be used.  

 

 

 

 

Figure 2.9: Brush tool  
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# Airbrush: Airbrush helps to create drawings with tiny droplets which will give the same 

effect as airbrush colouring. 

 

 

 

 

 

 

 

 

Figure 2.10: Airbrush tool 

2.5 Text, Shapes, Magnifier tools 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.11: Text, Shapes and Magnifier tool 

# Text tool  

 The Text tool is used to position and enter text into your image. 

 The size, style, colour of the text can be changed using the text menu.  

 

 

 

Figure 2.12: Text tool 
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# Shapes 

 Shape tool is used to include shapes like line, curve, rectangle, polygon, oval, 

rounded rectangle etc.,  

 Using these shapes, patterns can also be drawn. 

 

 

 

 

Figure 2.13: Shape tools 

# Magnifier 

 Allows you to zoom in or out of the file you are working on. 

 The Magnifying Glass, or Zoom tool, can be used to get a closer view of an image.  

 This is very useful if you’re working in close with the fine details of a part of an 

image. 

 

 

 

Figure 2.14: Magnifier tool 

Keywords 

 

 

 

 

 

 

 

 

 

 

 

 

A raster graphics editor: It is a computer program that allows users 

to create and edit images interactively on the computer screen and save them in one of 

many "bitmap" or "raster" formats such as JPEG, PNG, GIF and TIFF. 
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EXERCISES 

I. Fill in the blanks with the correct answer by using the words given below 

in the box. 

 

1. Paint is a simple raster ____________________ that has been included with all 

versions of Microsoft Windows. 

2. The thickness of the pencil tool can be changed using ______________ tab. 

3. Microsoft paint has a collection of ___________________________ that can be 

used for drawing colourful images and shapes. 

4.  __________________ is a basic drawing tool used to draw free form lines and 

curves. 

5. Pictures with tiny droplets can be drawn by using _________________ tool.  

II. Match the following tool names given in the column- I against the icons 

given in column- II. 

Column-I  

(Name of the Tool) 

Column-II 

(Icon) 

1. Fill with color 

 

A. 

 

 

2. Airbrush 

 

B. 

 

 

3. Magnifier tool 

 

C. 

 

 

4. Text tool 

 

D. 

 

 

5. Eraser tool 

 

E. 

 

 

 

Answers: 1. _______,  2. ________, 3. ________ 4. ________, 5. _________. 

 

Painting tools, Airbrush, Graphics editor, Size, Pencil 
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III. Write brief answer. 

1. In what format, Paint brush saves the files?      

2. What is the purpose of Magnifier tool? 

3. Name any four shape tools.      

PRACTICAL EXERCISES 

1. Draw the following picture using shapes and brush tools in paint. 

 

 

 

 

 

 

 

 

 

 

2. Draw a  “Nature scenery” using paint tools. 

3. Make a greeting card design for wishing your friend on his/her 

birthday using the paint tools. (Use text, airbrush and other required tools). 
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UNIT- III 

MORE IN PAINT 

3.1 Selection- Rectangular Selection, Freeform Selection 

 Selection tools are used to select portions of the image.  

 These selections can then be moved around, copied, or edited without affecting the 

rest of the image. 

# Types of selection tools 

   There are two options for selection: 

1. Rectangular selection: It allows selection of a part of the image in rectangle shape. 

2. Free-form selection: It allows a freeform selection, if the part of your drawing that 

you want to work with is crowded up closely with parts you don't want to include. 

 

 

 

 

 

 

 

 

 

Figure 3.1: Selection tool 

# How to use Rectangular selection tool 

 Click the rectangular selection tool. 

 Position the cross-hair cursor at the top left of the part you want to select. 

 Press your mouse button and drag down to its bottom right. 

 A dashed rectangle will appear around your selection, with the move cursor  replacing 

the cross-hair one.  

 You can press this cursor down anywhere inside your selection and drag to move it, or 

drag while holding the Ctrl key to make a copy of it. 
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# How to use Freeform selection tool 

 Click on the Freeform selection. 

 Drag your mouse around the area you want, as though you were drawing a line around 

it.  

 When you release the mouse button, a selection rectangle will appear and it may seem 

that unwanted parts of the drawing have been included, but if you move the selection 

you'll see that this is not so. 

3.2 View Menu 

 View menu contains 3 tabs: 

1. Zoom tab 

2. Show and Hide tab 

3. Display tab 

 

 

 

 

Figure 3.2: View menu 

# Zoom In 

 Zoom in icon,            is an option, under the Zoom tab. 

 Zoom in allows to get a closer view of the picture.  

 

 

 

 

 

 

 

 

                      Figure 3.3: An image, before clicking zoom in 
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                        Figure 3.4: Sample output after clicking zoom in option for the Figure 3.2 

# Zoom Out 

 The Zoom out,               is also an option under the Zoom tab.. 

 Zoom out allows to get a distant view of the picture. 

 

 

 

 

 

 

 

 

 

Figure 3.5: Sample output after clicking on zoom out option for the figure 3.3 
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3.5 Full Screen 

 The Full Screen icon               is available in the Display tab under View Menu. 

 The Full Screen is used to view the picture in full screen. 

 

 

 

 

 

 

 

 

 

Figure 3.6 : Sample output of Full Screen in paint 

 Press the Esc key to come back to a normal view from full screen view. 
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EXERCISES 

I. Identify the useful tools or keys given below in the box, for doing the 

task given below. 

 

II. Match the following tool names given in the column- I against the icons 

given in column- II. 

Column-I  

(Name of the Tool) 

Column-II 

(Icon) 

1. Zoom in 
 

A.  

 

2. Full screen 
 

B. 

 

3. Freeform selection 
  

C. 

 

4. Rectangular selection 
 

D. 

 

5. Zoom out 
  

E. 

 

Answers: 1. _______,  2. ________, 3. ________ 4. ________, 5. _________. 

Task Useful Tool or key 

1. To select a part of an image in a 

rectangle shape from an image. __________________________________ 

2. To get a closer view of the picture. 
__________________________________ 

3. To come back to a normal view, from 

the full screen view.  __________________________________ 

4. To select a small part from an image 

where it is surrounded by many 

patterns. __________________________________ 

5. To view an image in full screen. 
__________________________________ 

Esc key, Rectangular selection tool, Freeform selection tool, Full screen tool, Zoom in 

tool 
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PRACTICAL EXERCISES 

1. i. Draw the picture given below in paint. 

.   ii. Zoom in and view the picture. 

    iii. View the picture in Full screen. 

 

 

     

 

 

 

 

2. i. Write your name in paint using text tool, make the font size 72 and make it 

bold. (In place of the text “your name” write your name as given in the 

master of the school). 

    ii. Save the file with your name and view in full screen as shown below.  
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UNIT- IV 

ABOUT DESKTOP AND COMPUTER PERIPHERALS 

4.1 Purpose of Desktop 

 The desktop is an invisible folder. 

 Some of the most common icons on the Desktop include those for My 

Computer, Recycle Bin, your Internet browser (e.g. Internet Explorer) and My 

Documents.  

 On the Windows Desktop, you also have access to the Windows Start Menu through 

the Start button on the Taskbar, as well as the Windows Notification Area. 

 The date and time are also shown on the Desktop, in the notification area on the 

taskbar.  

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1: Desktop - Windows 7 

4.2 Identify Icons on Desktop 

 An icon is a small graphical representation of a program or file. 

 When you double-click an icon, the associated file or program will be opened.  

 For example, Double-clicking on the My Computer icon, opens Windows Explorer. 

 Icons are a component of most Graphical User Interface (GUI) operating systems, 

including Microsoft Windows. 

 Icons help users to quickly identify the type of file represented by the icon.  
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Figure 4.2: Icons of My Computer, Recycle bin and My documents 

4.3 Start Button and Taskbar 

# Start Button 

 Start button allows users to access their computer programs. 

 Clicking the Start button opens the Start Menu that provides access all the programs 

installed on the computer and other Windows features. 

 By default, the Windows Start button is found at the bottom left part of the desktop 

screen. 

 

 

Figure 4.3 : Start button 

# Taskbar 

 A taskbar shows the currently running programs list. 

 The default settings for the taskbar in Microsoft Windows are at the bottom of the 

screen. 

 This includes the Start menu button, Quick Launch bar, taskbar buttons, and a 

notification area from left to right as shown in Figure 4.n  

 

 

 

Figure 4.4: Start button and Taskbar 
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4.4 My Computer 

 My Computer is a section of Microsoft Windows that allows, exploring and managing 

the contents of the computer drives. 

 By clicking the My Computer icon on the desktop, the following screen appears, 

 

 

 

 

 

 

 

Fig: 4.5: Window appears when My Computer icon is clicked. 

 

4.5 Recycle bin 

 All the deleted files are moved to Recycle Bin. 

 If required, it can also be restored (get back) from the Recycle bin. 

(Tips: When the user wants to delete the file from the computer permanently, does not want 

the file the Recycle bin also then, use Alt+ Del. So that it will not go to Recycle Bin.) 

 

 

 

 

 

Figure 4.6: Recycle bin 
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4.6. Input and Output Devices 

# Input Devices 

The Input devices are used to give data and instructions to the computer.  

 

Some of the commonly used input devices are, 

 Keyboard 

o It is a commonly used input device, used to enter data and instructions into the 

computer. 

 Mouse 

o It is also a commonly used input device, used to move the cursor on a 

computer screen. 

 Scanner 

o A Scanner is an input device that scans images, printed text, handwritten 

documents and converts it to a digital image. 

o Scanners can be used to store documents and images in their original form. 

 Joystick  

o It is an input device consisting of a stick that pivots on a base and reports its 

angle or direction of the device it is controlling.   

o Mostly, used to control video games. 

 Trackball 

o A trackball is a computer cursor control device used in many notebook and 

laptop computers. 

o The trackball is an upside-down mouse that rotates in place within a socket. 

The user rolls the ball to direct the cursor to the desired place on the screen 

and can click one of two buttons (identical to mouse buttons) near the 

trackball to select desktop objects or position the cursor for text entry. 

 Touch screen 

o A touch screen is a display that can recognize a touch to its surface area, either 

with a finger or a stylus.  

o Touch screens are commonly used in cell phones, PDAs, ATM machines and 

even supermarket terminals. 
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Figure 4.7: Input Devices 
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# Output Devices 

The output devices are used to display the results to the user. 

Some of the commonly used output devices are, 

 Monitor 

o The monitor is a commonly used output device. 

o It is used to display the results or output to the user. 

 Printer 

o A printer is an output device that prints the output from a computer on a paper. 

o The output printed on  the paper is called as hard copy 

 Plotter 

o A plotter is an output device, much like a printer that is used for printing 

vector graphics. 

o Instead of toner, plotters use a pen as writing tool to draw multiple, continuous 

lines onto paper. 

o Plotters are used to print designs of ships and machines, plans for buildings 

and maps etc., 

 Projector 

o A projector is an output device, used to display presentations, images, videos, 

etc. to a large group of people, onto a surface, commonly a projection screen.  

 Speaker  

o A computer speaker is an output device that allows the users to hear audio 

output from the computer.  

o The signal used to produce the sound that comes from a computer speaker is 

created by the computer's sound card.  

o Laptop computers have built-in integrated speakers, usually small and of 

restricted sound quality to conserve space. 
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Figure 4.8: Output Devices 
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4.7 Keyboard, mouse, monitor, printer, speaker 

# Keyboard 

 It is a commonly used input device.  

 Used to enter data and instructions into the computer. 

 Normally, keyboard has 104 keys.   

 

 

 

 

 

 

Figure 4.9: Keyboard 

# Mouse 

 The mouse is also a commonly used input device. 

 It is used to as a pointing device. 

 Mouse is used to perform selection operation by left click, used to open pop-up menus 

by right click and used to scroll up and down on a page by scrolling. 

# Monitor 

 The monitor is a commonly used output device. 

 It is used to display the results or output to the user. 

 There are two types of Monitors 

o Cathode Ray Tube (CRT) Monitor 

o Liquid Crystal Display (LCD) Monitor 

Difference between CRT Monitor and LCD Monitor 

CRT Monitor LCD Monitor 

It is bulky in size and heavy. It is very thin, flat and light weight. 

Clarity is less when compared to the LCD 

Monitor 

Clarity is good 

Less Cost Expensive compare to CRT 

 

Table 4.1: Difference between CRT Monitor and LCD Monitor 
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# Printer 

 A printer is an output device that prints the output from a computer on a paper. 

 The output printed on  the paper is called as hard copy 

 A hard copy is so-called because it exists as a physical object. 

 There are two types of Printers 

1. Impact Printer 

2. Non- Impact Printer 

The following table shows the difference between Impact printer and Non-Impact 

printer 

Impact printer Non-impact printer 
The printer head strikes the ribbon, leaving 

the impression on the paper. 

The printer head does not strike the ribbon or 

paper directly. 

Its speed is slower. Its speed is faster. 

Its printing quality is lower.  Its printing quality is higher. 

It generates noise during printing. It does not generate noise during printing. 

It uses inked ribbon for printing. It uses toner or cartridge for painting. 

 It is less expensive. It is more expensive. 

An example for an Impact printer is Dot 

matrix printer. 

An example for the Non-Impact printer is 

Laser printer. 

 

 Table 4.2: Difference between Impact printer and Non-Impact printer 

 

# Speaker 

 A speaker is an output device 

 It is used by the user to listen to audio files. 

4.8 Memory Devices 

 Memory devices are used to store data, information, instructions, programs, software 

etc.,. 

 Memory devices are categorized into two types: 

i. Primary Storage Devices  

ii. Secondary Storage Devices 
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4.9 Primary and Secondary Memory 

Primary memory and Secondary memory are the two major categories of Computer Memory. 

Primary memory is classified into two types 

i. Random Access Memory (RAM) 

ii. Read Only Memory (ROM) 

# Random Access Memory (RAM) 

 Random Access Memory is a temporary memory. 

 The program which in running state remains on the RAM till completing its 

execution. 

 Whenever, the power supply is switched off, the contents of RAM get deleted. So, 

RAM is called as Volatile Memory. 

# Read Only Memory (ROM) 

 Random Only Memory is a permanent memory. 

 The manufacturer saves System files on the ROM 

 The user cannot write anything on the ROM. 

 Whenever the computer is turned on, the file on the ROM automatically gets 

executed. 

 Even though, the power supply is switched off, the contents of the ROM does not get 

deleted. SO, the ROM is called Non-Volatile Memory. 

# Secondary Memory  

 Secondary memory is also called as Auxiliary memory.  

 It is a permanent memory. The contents saved on the secondary memory does not get 

deleted when the power supply goes off.  

 Hard disc is the Secondary storage device available in the computer. 

 Some of the external secondary storage devices are  

 

o CD (Compact Disk) 

o (Digital Versatile Disk) 

o Pen drive 
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Figure 4.10: Storage devices 

4.10 CPU 

 

CPU stands for Central Processing Unit. 

The CPU has three subsystems, 

i. Memory Unit 

ii. Arithmetic and Logical Unit 

iii. Control Unit  

                                                     CPU 

 

 

 

 

 

 

 

Figure 4.11 : Subsystems of CPU 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hard disk- An Internal Secondary Storage device 
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 Memory unit stores the data and instructions. 

 Arithmetic and Logical Unit perform arithmetic operations such as addition, 

Subtraction, Multiplication and Division and logical operations such as AND, OR, 

NOT. 

 The Control Unit directs the operation of the other units by providing timing and 

control signals. Most computer resources are managed by the CU. 
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EXERCISE 

I. Write the full form for the following Abbreviations. 

i. CPU - ________________________________________________ 

ii. ALU    - ______________________________________________________ 

iii. CRT    - ______________________________________________________ 

iv. LCD    - ______________________________________________________ 

v. DVD    - ______________________________________________________ 

vi. CD      - ______________________________________________________ 

II. Jumble words 

1. NCIO  - ____________ 

    [Hint: A small graphical representation of a program or file] 

2. KSTARAB  - _______________ 

   [Hint: It shows the currently running programs list] 

3. ELCYCER NIB  - ______________________ 

   [Hint: All the deleted files are moved to this] 

4. PIRNETR  - _________________ 

   [Hint: It is an output device] 

5. VEIRDNEP – ___________________ 

   [Hint: It is an external secondary storage device] 
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III. Solve the crossword puzzle by using the hints given below. 

 

 

 

 

 

 

 

 

 

 

 

Hints: The words are related to Input devices 

Across 

2. An input device used to perform, selection operation by left click. 

4. An input device, mostly used in video games. 

5. An input device used in ATM. 

Down 

1. Used to enter data and instructions into the computer. 

3. Used to scan images and documents and converts it to a digital image. 
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IV. Identify and encircle, 5 words related to output devices from the word 

search puzzle given below. 

 

 

N V R H P G X O R L 
A S H W E P D O F B 
P P M O N I T O R I 
B J R Q U C E S P S 
K Y N I E M P Y L I 
V N H J N E G M O R 
Q S O R A T L N T S 
V R P K J P E G T K 
P E E V X W R R E U 
S R L M H U Q Q R S 

 

V. Write the difference between the following 

 

1. Dot matrix printer and Laser printer. 

 

2. CRT and LCD monitor 
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UNIT- V 

WORD PROCESSOR 

5.1 Introduction to Word 

5.1.1 What is Word Processor 

The word processor is application software, used to create and edit documents such as letters, 

notices, resumes, etc. Microsoft Word is an example of Word Processor, OpenOffice.Org and 

Word Perfect. 

5.1.2 Features of Word processor 

 Creating document 

 Save document 

 Formatting document  

 Editing the documents 

 Spelling and Grammar correction  

 Find and Replace 

 Printing the document 

 Protecting the document 

 Mail merge 

5.1.3 History of Word Processor 

 Word processing evolved from the needs of writers rather than those of 

mathematicians. 

 Typewriter: The first major advance from manual writing was the typewriter. Henry 

Mill, invented the first typewriter in the early eighteenth century. 

 Commercial Typewriter: Christopher Latham Sholes, with the assistance of two 

colleagues, invented the first successful manual typewriter in 1867. It began to be 

marketed commercially in 1874. 

 Portable model Typewriter: Typewriting was put within the reach of individuals by 

the development of portable models, first marketed in the early 1900s. 

 Electronic Typewriter: IBM introduced a more refined version of electronic 

typewriting, the IBM Electromatic in the 1930s. It had increased typing speed and 

was accepted quickly by the business community." 

 Selectric typewriter: IBM introduced the Selectric typewriter in 1961, which 

replaced the standard movable carriage and individual typestrikers with a revolving 

typeball. This could print faster than the traditional typewriter. 

 Magnetic Tape/Selectric Typewriter (MT/ST): In 1964 IBM brought out the 

MT/ST. It combined the features of the Selectric with a magnetic tape drive. Magnetic 

tape was the first reusable storage medium for typed information. With this, for the 
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first time, typed material could be edited without having to retype the whole text or 

chop up a coded copy. This development marked the beginning of word processing as 

it is known today. This allowed editing, simple revision, and repetitive typing, with a 

one-line display for editing single lines. 

 Similar word processing systems: Lexitron and Linolex developed a similar word 

processing system in 1972 and included video display screens and tape cassettes for 

storage. 

 Over the next ten years many new features were introduced like spelling check and 

mailing list programs, working on more than one document at a time on the same 

screen etc. 

 WordStar: Introduced by Micropro International, has emerged as the industry 

standard in software packages. 

 Microsoft Word: The first version of Microsoft Word was developed by Charles 

Simonyi and Richard Brodie, former Xerox programmers hired by Bill Gates and Paul 

Allen in 1981. Both programmers worked on Xerox Bravo, the 

first WYSIWYG (What You See Is What You Get) word processor.  

 MS word versions:  

o Word 1.0 was the first Word version, released in October 1983 .  

o Word became a huge commercial success, When Windows 3.0 was released in 

1990.  

o Word for Windows 1.0 was followed by Word 2.0 in 1991 and Word 6.0 in 

1993. Then it was renamed to Word 95 and Word 97, Word 2000 and Word 

for Office XP.  

o Word 2.0 was released in 1991, was used with Window 1.0. 

o Word 6.0 was released in 1993. 

o Word 2003 was released in 2003, the numbering was again year-based.  

o Since then, Word 2007, Word 2010, Word 2013, and most recently, Word 

2016 have been released for Windows. 

 

5.1.4 Steps for Starting Word Processor 

 Click on Start button 

 

 Click on All Programs 

 

 Click on Microsoft Office 

 

 Click on Microsoft Office Word 

The Window appears as shown in figure 5.1, where you can start typing the document. 
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5.2 Components of Word screen 

 

 

 

 

 

 

 

 

 

 

Figure 5.1: Components of Word screen 

#  The Components of Word screen are as follows, 

 Windows Control  

 Quick Access Toolbar 

 Title Bar 

 Ribbon 

 Office Button 

 Ruler 

 Vertical Scrollbar 

 Status Bar 

 

 Window Controls: Set of three buttons in top right corner. They are, 

o Minimize button 

o Maximize / Restore button  

o Close button 

 Quick Access Toolbar: It is a customizable toolbar that contains commands that we 

may want to use. The quick access toolbar can be placed above or below the ribbon. 

 Ribbon: The Ribbon is the panel at the top portion of the document. It has seven tabs, 

that contain many new and existing features of Word. 

o Home 

o Insert 
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o Page Layout 

o References 

o Mailings 

o Review 

o View 

 

 Title Bar: It displays the name of the currently active document.  

 

 Office Button: The Microsoft Office button performs many of the functions that were 

located in the File menu of older versions of Word. This button allows you to create a 

new document, open an existing document, save or save as, print, publish or close. 

 

 Ruler: Ruler is used to align text, graphics, tables, and other elements in your 

document horizontally or vertically. It is also useful for setting margins and tabs in the 

document.  

 

 Vertical Scroll Bar: It indicates which part of the document is currently on screen. 

The scroll box allows rapid movement in two ways: Dragging the scroll box, Clicking 

the scroll box 

 

 Status Bar: It provides information about active document like Page Count, Word 

Count. View Controls and Zoom Slider is also displayed on status bar. 

5.3 Creating a new Word Document 

 Steps for Creating a new Word Document 

o Click on Start button 

o Click on All Programs 

o Click on Microsoft Office 

o Click on Microsoft Office Word 2007 

o Click on Office button 

o Click on New. 

o The New Document Dialog box will appear as shown below. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 5.2 : New document dialog box 
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o Select Blank Document and click on Create button.  

o A new document will be displayed. 

5.4 Opening an Exiting Word Document 

 Steps for Opening an Exiting Word Document 

o Click on Office button  

o Select Open. 

o An Open Dialog box will appear as shown below 

o From this box, open document by double clicking on it or type File Name and 

click Open button. 

 

 

 

 

 

 

 

 

 

 

Figure 5.3 :Open dialog box 

5.5 Editing text in the Word Document 

5.5.1 Typing text 

 Steps for Typing text 

o A blank document starts out with a flashing insertion point, which looks like a 

small vertical bar.  

o Type the document using the keyboard.  

o Text you type appears at the insertion point. 
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Figure 5.4: Typing text in MS word 

 The following keys are used often, while typing. 

o Enter key, to start a new paragraph. 

o Tab key, to move to the next tab stop (by default every 0.5"). 

o Backspace key, to delete a single character to the left of the insertion point. 

o Delete key, to delete a single character to the right of the insertion point. 

5.5.2 Selecting the text 

Select is a very common action, because many tasks such as formatting, cut, copy and paste, 

start with the select action.  

 Steps to Select all text in a document 

o Click anywhere within the document. 

o Press Ctrl+A on your keyboard to select all text in the document. 

 Steps to Select specific text 

You can also select a specific word, a line of text, or one or more paragraphs. 

o Place your cursor in front of the first letter of the word, sentence, or paragraphs 

you want to select. 

o Click and hold while you drag your cursor to select the text you want. 
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5.5.3 Copy, Cut and Paste the text 

The Cut, Copy, and Paste tools are used to rearrange text within your document. Text must be 

selected before you can cut, copy, or paste it. Cut or copied text is automatically saved to 

the Clipboard (a special storage area).  

# Copy the text 

Copied text is left unaltered, in its original position and a duplicate copy of the text is placed 

on the Clipboard.  

 Steps to copy the text are, 

o Select the text you wish to copy 

o Click on the Home tab. 

o Click on the Copy option as shown below 

 

 

o The text is copied to the Clipboard. 

# Cut the text 

Cutting text will remove it from its original location in the document and place it on 

the Clipboard.  

 Steps to cut the text are, 

o Select the text you wish to move 

o Click on the Home Tab 

o Click on the Cut option as shown below 

 

o The text is removed from your document and placed on the Clipboard. 

# Paste the text 

The text which was copied or cut, can be pasted within the same document or into different 

documents. 

 Steps to Paste the text are, 

o Place the insertion point where you want to insert the text already copied or cut. 
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o Click on the Home tab 

o Click on the Paste option as  shown here, 

o The desired text is pasted to the selected location. 

5.5.4 Deleting the text 

 Steps to Delete Single Character 

o The Backspace key deletes the character to the left of the insertion pointer. 

o Delete key deletes the character to the right of the insertion pointer. 

 Steps to Delete a Line of text 

o Select the text to be deleted.  

o Press the Delete key, then the text disappears. 

5.6 Save the Document 

  Steps to save the Document for the first time 

o Click the save option as shown here,               on the Quick Access Toolbar. 

o Save as dialog box appears as shown below, type the file name.  

 

 

 

 

 

 

 

Figure 5.5 : Save as dialog box 

o Click on Save button 

The word file is saved with the .docx extension  

Word saves the document in a default location. To save the document in a particular location, 

select the appropriate folder name as shown in the figure. 
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EXERCISE 

I. Fill in the blanks using the words given below box. 

 

 

1. _______________________ is an example of word processor. 

2. Word processor an example of _____________________ software. 

3. MS Word 1.0 was released in ______________. 

4.  ________________ text will remove it from its original location in the 

document and place it on the Clipboard.  

5. ________________________ is a feature of the word processor. 

II. Solve the crossword puzzle using the hints given below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cutting, Word processor, formatting, application, 1983 
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Hints: The words are related to the topic “Components of Word 

Processor”. 

Across 

1. It contains sets of three buttons. 

4. It displays the name of the currently active document. 

5. The Panel, which has seven tabs, that contain many new and existing 

features of Word. 

Down 

2. It provides information about active document 

3. It is useful for setting margins and tabs in the document. 

III. Identify and encircle, 5 words related to menus in MS Word from the 

word search puzzle given below. 
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PRACTICAL EXERCISE 

Exercise 5.1: Do the following as directed. 

i. Open a new word document, type your name, Class/Section, Roll 

Number, School name as shown in the sample screen shot below.  

ii. Save the file with the name “mydetails”.  

iii. Close the file. 

 

 

 

 

 

 

 

5.6: Sample screen shot for Exercise 5.1 

 

Exercise 5.2: Do the following as directed. 

i. Open the file “mydetails”, copy all the details and open a new word 

document, paste the content copied from the “mydetails” file into this file. 

ii. The Class/Section, Roll Number, School Name from this file and save 

this new file with the name “MyName”. 

 

 

 

 

 

 

Figure 5.7: Sample screen shot for Exercise 5.2 
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UNIT- VI 

FORMATTING WORD DOCUMENT 

6.1 Formatting text 

6.1.1 Font size, style, color, sub/superscript 

 Steps to change Font size, style, color, subscript or superscript 

o Select the text for which size, style and color needs to be changed. 

o Right click and click on the font option, the font dialog box appears as shown 

below 

 
Figure 6. 1: Font dialog box 

o Choose the required font size, style, color, superscript or subscript. 

o Click on Ok button, the changes will be applied to the selected text as shown 

in the preview. 
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 6.1.2 Bold, Italic, Underline, background color  

 Steps to change the text into Bold, Italic, Underline: 

o Select the text for which size, style and color needs to be changed. 

o Right click and click on the font option, the font dialog box appears as shown 

below 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.2: Font dialog box to change the text into Bold, Italic, Underline 

o Choose the required font style underline style. 

o Click on Ok button, the changes will be applied to the selected text as shown 

in the preview. 
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6.1.3 Numbering and Bulleting  

# Numbering 

The Points in a word document can be numbered in a sequence automatically using the 

Numbering feature of MS word.  

 Steps to add Numbering in a document 

o Point the cursor, where numbering should start. 

o Right click and click on the Numbering option. 

o A Numbering library appears as shown below 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.3 : Numbering Library 

o Click on the required Numbering format. 

o The Number will be displayed. Type the Content . 

o Press the Enter key automatically the next number appears. 
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# Bulleting 

The Points in a word document can be listed using bullets (symbols) using the Bulleting 

feature of MS word.  

 Steps to add Bulleting in a document 

o Point the cursor, where bulleting should start. 

o Right click and click on the Bullets option. 

o A Bullet library appears as shown below 

 

 

 

 

 

 

Figure 6.4 : Bulleting Library 

o Click on the required Bullet format. 

o The Bullet will be displayed. Type the Content . 

o Press the Enter key automatically the next bullet appears. 

6.1.4 Alignment 

Text, images can be aligned left, right, center and justified. 

 Steps to Align 

o Select the text or keep the cursor on the text which has to be aligned. 

o Right click and click on the Paragraph option. The Paragraph dialog box appears 

as shown below, 
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Figure 6.5: Paragraph dialog box 

6.1.5 Change Case 

 Steps to change the lower case letters to upper case  

o Select the text to be changed as Capital letter . 

o Right click and click on Font option. The Font dialog box appears as shown below 

 

 

 

 

 

 

 

 

 

 

Figure 6.6 : Font dialog box 

o Click on the All caps option  

o Click on Ok button. The selected text will be changed into Capital letter. 
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6.1.6 Inserting the special characters and symbols 

 Steps to insert special characters 

o Place the cursor where special character has to be included 

o Click on the Insert menu bar 

o Click on the symbols option 

o The Symbols dialog box appears as shown below, 

 

 

 

 

 

 

 

 

 

Figure 6.7: Symbol dialog box 

o Click on the Special characters tab 

o Click on the required special character 

o Click on Insert button. The special character will be inserted in the document. 

 Steps to insert Symbol 

o Place the cursor where special character has to be included. 

o Click on the Insert menu bar 

o Click on the symbols option 

o The Symbols dialog box appears as shown below, 
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Figure 6.8: Symbol dialog box 

o Click on the required symbol. 

o Click on Insert button. The symbol will be inserted in the document. 

6.2 Insert Menu 

6.2.1 Word art 

Word art is used to decorate the text with some effects such as shadows, outlines, colors, 

gradients, and 3D. 

 Steps to include WordArt 

o Click on the Insert menu 

o Click on the WordArt command as shown here, 

o Edit WordArt dialog box appears as shown below, 

 

 

 

 

 

 

Figure 6.9: Edit WordArt Text dialog box 
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6.2.2 Page Break 

MS Word automatically inserts a page break at the end of each page when you create a 

document. You can also manually add a page break somewhere else in your document. A 

new page will be created, leaving the remaining space in the current page as blank. 

 Steps to Insert a manual page break 

o Place the cursor, where you want to break the page and go to the new page. 

o Click on the Insert menu. 

o Click on the Page Break command in the page group. 

o A new page will be created, leaving the remaining space in the current page as 

blank. 

6.2.3 Images 

MS word allows, Insertion and formatting of images such as Alignment, Rotating,  applying 

borders and changing brightness etc. 

 Steps to Insert an image 

o Place the cursor, where you want to insert the image. 

o Click on the Insert menu.  

o Click on the Picture command in the illustration group.          The Insert Picture 

dialog box appears as shown below, 

 

 

 

 

 

 

Figure 6.10 : Insert Picture dialog box 
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o Select the image file location. 

o Click on the image once, the file name should appear on the “File name” bar 

o Click on Insert button. The image will be inserted in the document. 

6.2.4 ClipArt  

Clip art is a collection of pictures or images that can be imported into a document.  

 Steps to add a ClipArt 

o Place the cursor where the ClipArt is to be inserted. 

o Click on  the Insert Menu 

o Click the on ClipArt command in the Illustrations group. 

o The clip art dialog box appears in the right. 

o Enter keywords related to the image you want to insert, in the Search for field. 

o Click on Go. It shows all the available ClipArts. 

 

 

 

 

 

 

 

 

 

Figure 6.11: ClipArt dialog box 

o Click on the ClipArt to be inserted. The ClipArt will be inserted where you placed 

the cursor. 
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6.2.5 Shapes 

Insert readymade shapes, such as rectangle, circle, arrow, lines, flowchart, symbols and 

callouts. 

 Steps to insert shapes 

o Click on  the Insert Menu 

o Click the on Shapes command in the Illustrations group. The Shapes menu 

appears as shown here, 

 

 

 

 

 

 

 

 

 

                         Figure 6.12: Shapes  

o Click on the required shape 

o Left click on the place, where the Shape is to be inserted. 

o By dragging the mouse with along with left click, the shape can be drawn. And 

drop the mouse when the shape has come to the required size. 

o If any text need be typed in the shape, right click and select Add Text option. 

o It will allow, text entry in the shape. 
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6.2.6 Text Box 

It allows to add preformatted text. 

 Steps to insert a text box 

o Click on the Insert Menu. 

o Click the Text Box command in the Text group. 

o Click on the required text box from the text box menu shown as below, 

 

 

 

 

 

 

 

Figure 6.13: Text box  

o For example, if Alphabet Quote text box option is selected, it appears as shown 

below, where it allows editing of the text. 

 

 

 

 

 

Figure 6.14: Alphabet Quote text box 

[Type a quote from the 

document or the summary 

of an interesting point. 

You can position the text 

box anywhere in the 

document. Use the Text 

Box Tools tab to change 

the formatting of the pull 

quote text box.] 
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6.2.7 Page Number 

Page Number allows to insert page numbers into a document. 

 Steps to insert a Page number 

o Click on the Insert menu 

o Click on Page Number option in Header & Footer group. 

o The following options are available as shown below, 

 

 

 

 

 

 

 

Figure 6.15: Page Number 

o Click the location where the page number is to be inserted. Some samples 

appear on the screen. 

o Click on the required sample and press enter. The page number will be 

inserted. 

 Formatting the Page Number 

o Page number can be formatted, by clicking the Format Page Numbers option 

given in figure 6.14. 

o Page Number Format dialog appears as shown in figure 6.15 

o Select the required page number format from the group of Arabic numbers, 

negative numbers, roman numbers, lower case alphabets and upper case 

alphabets. 

o Click on Ok button. 
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Figure 6.16: Page Number Formats 

6.2.8 Date and Time 

# Steps to Insert Date and Time 

o Place the cursor, where the Date and Time is to be inserted 

o Click on the Insert menu 

o Click on Date and Time in the Text group. 

o The following Date and Time format options are available as shown below, 

 

 

 

 

 

 

Figure 6.17: Available Date and Time formats 

o Click on the required Date and Time format. 

o Click Ok button. 

o The Date and Time will be inserted, where the cursor was placed. 
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PRACTICAL EXERCISES 

Exercise 6.1: Do the following tasks, as instructed below. 

i. Create a new word document. 

ii. Type any five points about,  “Do’s and Don’ts in the Computer Lab” in 

small letters, insert bullets for all the points. 

iii. Make font size 12, font face Times New Roman, font color green for 

the point in “Do’s in the Computer Lab” red color for “Don’ts in the 

Computer Lab”. 

iv. Align the heading in the center. 

v. Change the font into Capital letters. 

vi. Save the file with the name “Instructions_ComputerLab” 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.18: Sample screen shot for Exercise 6.1 
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Exercise 6.2: Do the following tasks, as instructed below. 

i. Open a new word document. 

ii. Insert WordArt and type the name of our national animal-tiger. 

iii. Insert ClipArt of a tiger. 

iv. Insert a rectangle shape and add the text “ Tiger is Our National 

Animal”. 

v. Insert page number at the bottom of the page and Insert the Date and 

Time. 

 

 

 

 

 

 

 

Figure 6.18: Sample screen shot for Exercise 6.2 

 

 

 

 

 

Figure 6.19: Sample screen shot for Exercise 6.2 
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UNIT-VII 

INTERNET 

7.1 Introduction 

  The Internet is defined as a network of networks. 

 Two or more computers connected together for communication and data sharing is 

called Network. 

 

 

 

 

 

Figure: 7.1 Internet 

7.2 Need of Internet 

Nowadays, the Internet has become a basic need for everyone for the following purposes. 

 Communication 

 Data Sharing 

 Electronic business/ Online transactions 

 Entertainment 

 Education 

 

 

 

 

 

Figure 7.2: Need of Internet 
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7.3 Requirements for accessing the Internet Connection 

# Wired Broadband Connection 

 Requirements for accessing the internet through a Broadband 

Connection 

o A computer or a Laptop 

o A modem and telephone line or A dedicated data connection. 

o An Internet browser  

o An account with an Internet Service Provider (ISP) souvenirs 

# Wireless Broadband Connection 

o Wireless broadband connection provides internet access on the move or in the 

home. 

o Wireless broadband works by providing Internet over a mobile operator's 

3G/4G network. 

 Requirements for accessing the internet through the Wireless 

Broadband Connection 

o A Computer or a Laptop 

o Broadband USB Modem or Dongle that you simply plug into your laptop or 

home PC. 

 

 

 

 

 

Figure:7.3: Dongle 

7.4 Steps to open Web Browser 

A Web browser is a software that lets you view the contents of web pages.  

o Double click on the web browser icon, for example Google Chrome.  

o The web browser window appears as shown below, 

 

Dongle: A small 
device able to be 
connected to and 
used with a 
computer, especially 
to allow access to 
wireless broadband 
or use of protected 
software. 
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Figure 7.3: Web browser window 

7.5 Search engines 

Search engines are the programs which are needed to extract the information from the 

internet. They play a very important role in searching the information on the internet. 

# Some of the search engines are, 

 Google 

 AOL 

 Bing 

 Webcrawler 

 Ask 

 Yahoo! 

 Mywebsearch 

 Info.com 

 

 

 

 

Figure 7.4: Search engines 
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7.6 Finding/ Downloading/ Saving images 

Search engines allow searching, selecting and saving the required images from the internet. 

 

 Steps for finding/ downloading/ saving the images  

 
o Open the web browser and search engine.  

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

Figure 7.5 : Finding an image 

o Type the keyword related to image to be searched. 

o Click on Google Search button. 

o Many images will be displayed related to the keyword as shown below, 

choose appropriate image and double click on image to enlarge its size.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.6: Results of Google search for the keyword “Garden” 
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o Click on the required image. The enlarged image appears as shown below, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.7: The enlarged image 

 

o Right click on the image and click on Save Image as an option. 

o Save as dialog box will open, select the location where you want to save the 

image.  

o Click on save button. The image will be saved in the selected location. 
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EXERCISE 

I. Fill in the blanks with the correct answer, using the words given below in 

the box. 

 

1. Two or more computers connected together for communication and data sharing 

are called_______________________. 

2. ___________________ is a small device used to access internet on the move. 

3. ____________________ are the programs which are needed to extract the 

information from the internet. 

4. Network of networks is called as ______________________. 

5. ISP full form is _____________________________________ 

II.  Solve the crossword puzzle. 

[Hint: Words represent, some of the search engines] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dongle, Search engines, Network,  Internet Service Provider, Internet Clue Box 
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PRACTICAL EXERCISE 

Exercise 7.1: Download the image of our national bird and save it on the 

desktop of your computer. 

ACTIVITY 

 Showing a demo of searching a flower image and saving it on the desktop 

from internet using projector. 
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